First Steps Beginner-level tutorials
for users dipping their toes into Linux

First Steps: Use
Summer holidays will soon be looming and you want to make the most of
your two weeks off work. Andy Channelle gets his computer on the case…

A

nticipation is the sibling of hope, but can also be the daddy
of disappointment. This is especially true when it comes
to holidays; we’re seduced by glossy brochures, wellhoned sales patter and the expectation that any time away will
remove us enough from ‘reality’ to give us a break from our
mundane lives. Unfortunately, it doesn’t always work out that way,
but a Linux box can help us plan routes, excursions and many
other aspects of our break, and make the actual experience of
going away a little less stressful. In this tutorial we’ll use Google
Maps to plan out everything to do with a holiday jaunt, then
transfer the data to Google Earth for more manipulation. We’ll also
look at ways to add data to this project, post-holiday, to create a
capsule of the event for sharing with friends and family.
All of the tools we’ll be highlighting are free to use and often
just require you to register for the appropriate service or, in the
case of Google Earth, download and install the Linux binary. While
we’ve opted for a Google-biased selection here, much of this
project could be accomplished using a similar range of tools from
Yahoo (Yahoo Maps, Flickr) and even Microsoft’s Live offerings; our
choice has largely been based on the availability of Google Earth
and Picasa (Google’s image management software) for Linux,
which makes the latter part of the project possible.
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To kick off, browse to http://maps.google.co.uk. To make the
most of this service you’re going to need a Google account, so
either log in with an existing one or hit the Create Account button
to make one. This service is free and, as it’s completely web-based,
all the information you add will be accessible from any net-enabled
computer. At its most basic, you can use this service without an
account – just input a postcode, map coordinate or location in the
search box to see maps and satellite imagery of that location. For
more, an account is essential.
The Maps interface is very simple: the main work area is on the
right, with a few tools ranged along the top-right, while a selection
area is on the left of the screen. Once you’ve logged into your
account, this section on the left should have two tabs at the top
labelled Search Results and My Maps: the latter will be further
sub-divided into Featured Content and maps created by you. We’re
going to work in the My Maps section to start with.
Hit the Create New Map link on the right and supply an
appropriate name, and optionally a description, for this map.
Underneath this information is a pair of radio buttons, which
define whether the rest of the world can see your efforts. As the
wider world is probably not interested in your holiday plans, we’ll
keep things private by selecting the Unlisted option and then
hitting Save. We have a few tasks we want to accomplish, so we’ll
start by adding our two base locations: home and holiday. Begin

by entering your postcode into the search box to centre Maps on
your house. More refined navigation is accomplished by clicking
and dragging to move the centre of the map or – to zoom in and
out – by using the scrollwheel on your mouse. You can also use the
icons on the left of the main window. To put a placemarker on your
house, click on the Placemark icon (second left on the top-left

You can create maps for a variety of purposes and corral them
into this section of the Google Maps website.

Last month We found out how to save time with templates in OpenOffice.org.
80 Linux Format June 2008

LXF106.tut_begin 80

14/4/08 15:18:57

First Steps Tutorial

digital maps

The Edit HTML button means you can create very rich points
of interest for your own maps.

edge of the main window) and then move your mouse to the
appropriate location and click. This will drop the placemarker and
open up a labelling window. In here, you can add a description of
the location or any other information relating to that point. Your
text can be plain or ‘rich’, meaning it’s possible to add images,
hyperlinks and almost anything HTML is capable of displaying.
There’s no facility to upload images to Maps, so either add an
image to an online service such as Flickr, upload one to your
personal web space or find one to link to on the internet. When
you’ve found an image, copy its address by right-clicking on it in
Firefox and selecting Copy Image Location, then paste it into the
address bar that appears when you click the Image icon in Maps.
The picture will appear in its native resolution and, if this is too
big for the space available, the size can be edited by clicking the
Edit HTML link in the window and changing the value labelled
Width to something more suitable. When you only adjust this
number, the picture will retain its original aspect ratio. Another
simple edit worth doing here is adding the following text just after
the URL of the image (but outside the URL’s quote marks):
align=”left”. This will push the picture to the left of the space and
enable the text to run around it in a more tidy fashion.
You can add a link to a word or image by selecting it with the
mouse and clicking the Link icon, then adding a web address to
link to. As with the image above, there are further options available
for configuring links if you know a little HTML. For example, it’s
possible to make a link open in a new browser window by adding a
target value in the Edit HTML section:
<a href=”http://www.mytown.org” target=”_blank”>My Town</a>
The code above would insert a link to the website named and,

when the link was clicked, would open it in a new window. It’s also
possible to define the icon that will represent the point on your
map. Click the generic icon at the top-right of the window to open
up a selection of available icons, and if none of these feel suitable,
click the Add An Icon link and use the dialog box to link a new one
from somewhere on the web such as Flickr, Photobucket or
Picasa. The software can manage JPEG, PNG or GIF format, and
any images larger than 64x64 pixels will be scaled down.
Once you’ve created this location, hit the Done button and then
do the same for your destination. It’s likely that the destination box
will grow as the holiday draws near and you find more stuff to add,
so if you’re using a picture, stick to a small image to start with.
When you’ve finished, click the Done button to write everything
back to the server. Your icons will remain visible on the map
(unless you’ve clicked the radio button next to the map’s name)
and clicking on them will bring up an information box containing
the data you’ve added. These locations are also noted on the lefthand pane of the user interface, so it’s possible to select locations
without them being on the exposed part of the map.
As well as placemarks, we can also add lines to the maps and,
handily, get a distance reading. Here’s an example: say you want to
work out whether it’s quicker to walk from your holiday home to
the nearest beach on the road or via the coastal path. Using the
Line tool (third icon from the left) you can create a line by clicking
the start of the route and then clicking control points at various
locations, following the path of the road. As more points are added,
a distance readout appears in the tooltip accompanying the Line
tool. When you hit the beach, double-click to finish drawing and
then click the line once more to begin adding a label. These labels
can contain the same kind of information as a placemark.

Quick
tip
See how the night
sky will look from
your holiday home in
Google Earth. View
> Switch to Sky.

Dynamic and imported data
Now we have these two locations defined, we’re going to add
some dynamic data – information that’s updated constantly from
a different source. We have two ‘data layers’ that we’re going to
add, but rather than putting these on top of the locations we’ve
already defined, we want them to function as completely separate
maps. The reason for this is that the kind of information these
layers contain – weather and traffic reports – will be useful as the
holiday gets closer, but will just clutter up the map in the
intervening time. The first of these, the weather, is very simple.
Just scroll down the list of available content and select the map

The final
result is a map
that contains a
lot of bespoke
information, as
well as other
useful stuff added
automatically, such
as bus timetables.
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labelled The Weather Channel. The map will re-centre on the US,
but if you click on one of the locations added earlier, it will spin
back to the UK and you should see weather icons dotting the map,
including the temperature and current conditions.
The second element is a little more complex but, again, the
hard work has been done for us, this time by the BBC’s Backstage
project. To get this working, you need to select Create A New Map
from the left-hand pane and choose Import from the options just
below the list of user maps. The information will come into Maps
using GeoRSS feeds, which, as the name suggests, are location
specific. The URL you need to enter will be like this:
http://maps.google.co.uk/maps?q=http://bbc.blueghost.co.uk/
trafficGeoRss.php?location=locationname.
The last part, locationname, should be the name of the location
you’re interested in viewing – a list of available locations is
available from http://bbc.blueghost.co.uk/travel_data/
locations.rss. For our project we’ll enter the location name
cornwall and then hit the Done button. We’ll now have two distinct
user-generated maps under the Created By Me section and one
switched on from the Featured Content section.

Finally, we’ll add some information about the destination to
build up a comprehensive picture of events and venues available
near the holiday home. This begins with a normal Maps search,
so select Find Businesses at the top of the window and input two
search strings. The first should be the kind of business you’re
looking for (we’ll start with pubs) and the second is the location
itself, so input the postcode of the holiday home. This produces
about eight results within just a few miles, but we’re just going to
add the two nearest establishments to our map. Add a result to
your map by clicking on it and selecting Save To My Maps. A new
option should appear in the Placemark box with a drop-down list
of available maps. Choose the appropriate map and hit Save. The
result is a new placemarker on your map that can be edited and
amended in the same way as any other element.
Using this method, it’s possible to add all the information
you’re likely to need to ensure you have a restful break. And if you
do it via the search method, you’ll automatically have data such as
phone numbers, postcodes and even reviews to hand. Having
defined our locations and points of interest, we’re now going to
save the whole thing as a file ready to load into Google Earth.

Part 2 Google Earth

Quick
tip
To make the most of
your hardware,
adjust Google
Earth’s settings in
Tools > Options.

Once you’ve visited http://earth.google.com and downloaded
the binary for Linux to an appropriate location – the system
should work out that you’re a Linux user and offer to download the
correct version – you can get installing. The current version is 4.2,
but the website should automatically serve up the latest version
using a fairly generic name.
The installation is going to involve a brief trip to the command
line, so open up your favourite terminal/console and navigate to
the correct directory. When you open a terminal it should ‘be’ in
your home directory, so if you’ve saved the binary to a folder called
Downloads inside your home directory, you can type cd
Downloads and hit return to go into that directory, remembering
that Linux directory names are case sensitive. If you’ve buried the
binary somewhere else, you can use the forward slash character
to go further into the system. Typing:
cd documents/Downloads/Earth
would take you through the documents and Downloads
directories and into Earth. Once you’re in the right place we can
launch the Google Earth installer with the following command:
sh GoogleEarthLinux.bin
In this command string, the sh tells the computer that you’re
executing a shell script, and the second part is simply the name of
the script. It almost goes without saying that, this being a Google
project, you’re going to need a constant connection to the internet
(and a fairly good one at that) to use it properly. Once the script
has executed, which took less than 30 seconds on a recent
MacBook, the application will automatically launch and present a

The installer is
accessed via the
command line, so
don’t attempt to
double-click the
file itself.

The terrain view tells us that the coastal path is probably a bit
much for tired legs. Best stick to the road.

view of the world ready for a bit of exploration and the addition of
your data. It will also put a shortcut into your menu system, most
likely under the Internet section.
With Earth installed, go back to the browser, ensure the correct
map is highlighted and then click the View In Google Earth link.
This will fire up the Google Earth application and load the selected
map into its Temporary Place space, which means it will be
discarded next time you launch the application. To prevent this
from happening, click the map name and drag it from Temporary
Places to My Places. You can see more detail about the ‘layer’ –
which is what this is – by clicking the disclosure (+) icons to
expose the elements. Zoom in to an element by selecting it.
The great thing about using Google Earth for this purpose is
that a lot of extra information is added automatically to your
efforts. For example, the small blue dots visible on the screenshots
on these pages are photos submitted to the Panoramio service
(of course, you’re free to add your own at www.panoramio.com),
while the orange dots display articles of interest culled from a
variety of sources, including Wikipedia, the Council for British
Archeology and other organisations.
Some of the tools in Earth mirror those in Maps, with a few
additions. It’s possible to navigate around the space by dragging
and mouse-wheel zooming, or by using the icons on the top-right
of the main screen. One of the big advantages of Earth is that you
can tilt the camera back to see what the terrain around a certain
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What, no route?

Content in Google Earth can help provide a good impression
of where you’ll be staying, including the area’s history.

point looks like. This is both pretty and useful, as it’s possible to get
an impression of, for example, how strenuous a walk to the beach
is likely to be and also a better impression of relative distances to
places such as the local pub.
With the map tilted, the Pan and Zoom tools work in the same
way, but now give the impression that you’re flying across the
landscape – which is great for visualising a journey before you get
into the car.
Because Google Earth and Maps both use the same data
format, content added to one service can be simply added to the
other. This means it’s possible to select the best tool for the job at
hand. For example, we’ve found building up lines of travel and
short routes is better in Earth because we have a better
understanding of the ululating terrain, but creating longer routes

The one big omission from the project so
far is the route from home to destination
and back again. Well, it makes sense to do
this element last so that you can tailor the
whole thing and avoid any foreseeable
traffic jams.
On the morning of the trip, you can
boot up the machine, browse to your map,
switch on the Traffic Alert layer, as defined
in Part 1, and then plan the route by
clicking on the destination and selecting
the Get Directions To Here link.
After inputting the starting point, the
software should work out the quickest
route between the two locations, but it’s
possible to adjust the route – for example,
if Google attempts to take you through
major roadworks – by clicking and
dragging any point on the route to a new

Avoiding potential traffic jams is
easier when you have up-to-date
information at your fingertips.
‘way point’. In this way you can also define
certain locations you’d like to visit on your
journey, with the software working out the
most efficient route to take you to your
destination. Just don’t forget to print out
your maps before you hit the road.

and finding things to do is easier in Maps, owing to its tight
integration with Google Search. Maps also provides better printed
output and easier methods for integrating third-party data. Both
working together should ensure you’re set and ready for the best
summer holiday ever. Moreover, because everything is on the
internet, it’s possible to share your accumulated information with
other would-be holiday-makers by giving them a single URL to
view in their browser.

Part 3 Map your photos
So you’ve been, relaxed and returned. Now it’s time to make sense
of the experience and give your friends and family the opportunity
to look at your holiday snaps. We’re going to use the Picasa Web
Albums service to upload a few photographs and then tag them
with the location in which they were taken, and this can then be
exported to Google Earth as a new layer of information.
If you created an account for Google Maps earlier, you’ll
automatically have a Picasa Web Albums account, so go to
http://picasaweb.google.co.uk and log in. We need a home for
the photos, so click the New Album button and give the album a
name. Next, select the Upload Photos button and upload the
photos you’d like to include. If you’re using Picasa for Linux, you
can do all of this within the application.
The images will take a while to upload, but when that’s done we
want to add captions to each picture in turn and then, by clicking
the Add Location link, define the location of the shot (if you have a
GPS-enabled camera, this might be included automatically in the
picture metadata). The tool for doing this is Google Maps, and you
can search by place name, postcode or road and then refine the
position of the placemarker by dragging and dropping. Finally, hit
Save Location to tag the picture with some geographical data.
When each photo has been tagged, navigate into the album
itself and choose the View Map option. This will display a map
encompassing all of your pictures, which can be zoomed and
panned like any other map. But now, instead of placemarkers, the
map will be littered with thumbnails of pictures associated with
each location. Click a thumbnail to see the image in all its glory.

You’ll also notice, in the top-left corner of the image, a pop-up link
marked Play: this will cycle through your images slideshowfashion, moving automatically around the map as it does so.
The final step is to send the entire production to Google Earth
as we did with the planning at the beginning. Simply click the Open
In Google Earth link and wait as the whole thing is loaded up. Now,
in Earth, we can move the file – as before – into My Places then
right-click the filename, select Save As and provide a location and
name to save the resulting KMZ file. This file can then be emailed
to friends or posted to your blog, so that anyone can download
your own Google Earth layer to peruse at their leisure.
Every holiday has three phases: anticipation, fulfilment and
memory. And, despite being a seemingly cold collection of silicon,
plastic and metal, your Linux PC can play a part in each. LXF

Quick
tip
Ctrl+Alt+A will
launch you into the
Google Earth Flight
Simulator, so you
can soar over your
holiday destination.
Next time you need
it, the option will be
under Tools > Enter
Flight Simulator…

Review your
holiday highlights
with Picasa.

Next month We uncover some of the new features in KDE 4
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